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1 General 
 
 
LUXORliving smart home control is based on a bus communication and includes control of 
lighting, actuators and indoor climate. LUXORliving is taken into operation by using the free 
LUXORplug programming tool.  
(http://luxorliving.de/luxorplug/)  
 
LUXORplug assigns all functions, which can also be changed later on. 
 
Operation is done via permanently installed operating controls or by using the free LUXORplay 
app, which can be installed on a smartphone or tablet.  
 
For iOS - App Store           
 
For Android - Play Store   
 
 

 When operating via app, the LUXORliving IP1 system control centre has to be connected 

to your home network. 
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2 System 
 

 All components of LUXORliving communicate via a bus connection according to the KNX 
standard (KNX S-mode).  

 
 The connection to the home network is via the LUXORliving IP1 system control centre. 

This allows operation via the LUXORplay app. 
 

 The system can be equipped with a maximum of 64 LUXORliving devices, which 
includes system devices, sensors and actuators. 
 
System devices 
- LUXORliving IP1 (system control centre),  

- LUXORliving P640 (power supply)1 

 
Sensors 
- Room sensors 
- Binary inputs 
- Button interfaces 

 
Actuators 
- Switch actuators 
- Dimming actuators 
- Blind actuators 
- Heating actuators 

 

 

 For operation, conventional buttons are used. They are integrated into the system via 

button interfaces/binary input. Control is always via button. Only for the "switch" 

function you can chose between "button" and "motion detector" (switch). 

 
 
 
 
 
 
 
 
 
   

                                                 

 

 
1 Only one system control centre and one power supply are allowed to be installed in one system. 
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3 Installation 
 

 The components of LUXORliving are intended for installation in a switch cabinet, in a 
flush-mounted box, or for wall mounting.  
 

 Communication is via a 2-wire bus, to which each device has to be connected. The bus 
connection can be executed as a line, star or tree topology. 
 

 The following cable lengths have to be observed: 

power supply – participant   max. 350 m 

participant – participant    max. 700 m 

total cable length     max. 1,000 m 

For the bus connection, a KNX-certified bus line (J-Y(St)Y 2 x 2 x 0.8 mm) has to be used. 

 

 For operation, conventional buttons are used. They are integrated into the system via 

button interfaces/binary input. Control is always via button. Only for the "switch" 

function you can chose between "button" and "motion detector" (switch). 

 

 Please note that outdoors, a bus line can pose an increased safety risk. As an alternative 

in the outdoor area, normal motion detectors with relay contact can for instance be 

integrated into the system via the LUXORliving B6 binary input. When using the 

LUXORliving M140 weather station, installation location and cable routing should be 

chosen in a way, so access to the bus line is difficult. 
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4 Start-up 

4.1 Establish a connection 

 
LUXORliving is always put into operation by using the LUXORliving IP1 system control centre and 
the LUXORplug software. The LUXORplug software can be downloaded for free at 
https://www.theben.de/ (http://luxorliving.de/luxorplug/).  
 
For operation, the LUXORplay app is used, which is also available as a free download for your 
smartphone/tablet (http://luxorliving.de/demoversion-luxorplay-2/) (see page 3). 
 

 System requirements for LUXORplug:  

- Windows 7 to Windows 10 

- 32 bit and 64 bit 

 

 System requirements for LUXORplay:  

- Windows 7 to Windows 10 

- 32 bit and 64 bit 

- Android from version 4.4,  

- iOS from version 9.x 

 
The connection between PC and LUXORliving IP1 system control centre can be established in 
various ways. We recommend the connection via a router: 
 

4.1.1 Option 1 – Connection via a router 

 Connect PC (WLAN or LAN) and LUXORliving IP1 system control centre (LAN) with the router 

and switch on the power supply of the LUXORliving IP1 system control centre.  
 
The LUXORliving IP1 system control centre is delivered with activated DHCP service and receives 
its IP address automatically from the router. After start-up, the IP address is displayed in the 
LUXORliving IP1 display.  
 
If the router does not support DHCP, the IP address of LUXORliving IP1 has to be assigned 
manually. Please find further information on this in the manual of the router. 
 
In LUXORliving IP1, the IP address can be configured as follows: 

 Press the "    " button and open the "IP Config" menu with the "     " button. 

 Select the "DHCP" setting with the "     " button.  

 Set it to "Manual" with "    ", and confirm with "      ". Now, you can set the IP address, 

subnet mask and gateway by using the arrow keys. 

e.g. IP address 192.168.0.100/subnet mask 255.255.255.0/gateway 192.168.0.1 

 

https://www.theben.de/


 Start-up 

 

LUXORliving system manual  8 

 

 

4.1.2 Option 2 – Connection without router using the DHCP service of 

LUXORplug 

 
Via an integrated DHCP service in LUXORplug, an IP address can be assigned to the LUXORliving 
IP1 system control centre and the PC. This changes the network settings, which requires the 
appropriate access rights. When exiting LUXORplug, these settings will be undone. 
 

 Start the LUXORplug application "As an administrator", and activate "Settings" – "Direct 

connection to LUXORliving IP1" in the "File" menu. 

 

 

 

 Update the adapter settings and start the process with "OK". 

 

 

 In the firewall settings, allow access in "Public networks". 

 Afterwards, an IP address will be assigned to the LUXORliving IP1 system control centre as 

well as the PC. 
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4.1.3 Option 3 – Connection without router using manual network settings 

 Deactivate the WLAN connection at the PC. 

 Use a network cable to connect the PC directly with the LUXORliving IP1. 
 
The PC normally obtains the IP address automatically via an existing network. Since no network 
is available, the IP address of the PC has to be set manually. This setting has to be made in the 
control panel.  

 The following settings interrupt possibly existing network connections. This might lead to 
a loss of data in open applications.  

 Close all applications, before making these changes. 
 
 
Example 

 Open the file explorer (by using the shortcut Win + E), right click on "Network" and select 

"Properties". 

 In the new window, click on "Change adapter settings".  

 A list with the connections of all network adapters will be shown.  

 Double click on the "Ethernet" connection and open "Properties".  

 In a new window, double click on "Internet protocol, version 4 (TCP/IPv4)".  

 In the following window, activate the entry "Use the following IP address".  

 Complete the fields below correctly.  

e.g. IP address 192.168.0.10/subnet mask 255.255.255.0/gateway 192.168.0.1 

 

 Undo these settings after finishing your activities in the LUXORliving system and activate 

DHCP. 

 
At LUXORliving IP1, the IP address has to be set manually as well: 

 Press the "    " button and open the "IP Config" menu with the "     " button. 

 Select the "DHCP" setting with the "     " button, set it to "Manual" with "     " and confirm 

with "     ".  

 Set the IP address, subnet mask and gateway by using the arrow keys. 

e.g. IP address 192.168.0.100/subnet mask 255.255.255.0/gateway 192.168.0.1 

 The connection between PC and LUXORliving IP1 is now established. 

 Start the LUXORplug application and start configuration. 
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4.2 Configuration with LUXORplug 
 
For creating a project, the following steps have to be done: 
 
- Project details (project name, address, etc.) 
- Create building structure (floors and rooms) 
- Create a device list (loading the system or creating the device list manually) 
 

 Only if the last step is confirmed with (), the device list will be saved in the project! 

 

 Click on the             icon. 
 

 The home page appears with the following information on the project: 

 

 

 

 Enter project name, address, installer etc. 

4.2.1 "File" menu 

 
In the "File" menu, several functions are available. 
 
New project:  Create a new project 
Open project:   Open an existing project 
Import project:  Import a project file from LUXORliving IP1 
Previous projects: List of previously edited projects 
Save:   Saves the current project with the most recently selected filename  

and storage location 
Save as:  Save the current project with the save dialogue (filename and storage  

location selectable) 
Settings:  Set the menu language of LUXORplug, demo mode,  

Activate direct link and debug mode 
Quit:   Quit and exit LUXORplug 
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Functions of the menu "File" – "Settings" 
 
Demo mode  
In demo mode, the connection to a system is simulated. This mode is used for displaying the 
LUXORplug functions and has to be disabled if there is an existing connection to a LUXORliving 
system. 
 
 
Direct connection to LUXORliving IP1  
This function is used if LUXORliving IP1 is connected directly to the PC via a LAN cable. When 
activated, a DHCP service is started in LUXORplug, which automatically assigns an IP address to 
LUXORliving IP1 and to the PC. For this, the network settings of LUXORliving IP1 and PC must 
have activated the DHCP service.  
 
 
Debug mode 
Debug mode can be activated by clicking five times on the free space. Debug mode is used for 
troubleshooting in the configuration. You can find further information in the Appendix. 
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4.2.1.1 Define floors and rooms 

 
By navigating with the arrow icons, you can go one menu step ahead () or back (). 
In the next step, you can define the number of floors and include the corresponding rooms on 
each floor.  
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 



 Start-up 

 

LUXORliving system manual  13 

 

 

4.2.1.2 Further functions 

 

 Add further floors or rooms 
 

 Delete floors or rooms 
 

 Edit floors or rooms  
 

 Click on the pin. In this way, you can change the names of rooms and floors.  

 Click on a room (e.g. bedroom) 

  A choice of alternative icons for the respective room is displayed. 

 
 

 In room view, place the cursor on a room. 

 The functions configured in this room are displayed. 
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4.2.1.3 Load devices of the system 

 
By navigating with the arrow icons, you can go one menu step ahead () or back (). 
In the next step, you can load the system.  
 

 In order to do this, the PC must be connected to LUXORliving IP1 and other LUXORliving 

components. As an alternative, you can skip this step and create the device list manually. 

  Click on the "Load system" field. 

 

 
 
The connected LUXORliving components are automatically loaded and then shown in the device 
list. 
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The arrangement of the devices in the left column (devices) can be adjusted by clicking, holding 
and moving. 

4.2.1.4 Identify and name devices 

Each device has to be clearly named, in order to be assigned to functions and rooms. For 
instance, each device can show the installation location, function or another identification.  
 
For identifying the device inside the installation, the "magnifying glass" icon is used.  

 Click on the "magnifying glass".  

 The red LED of the device flashes and allows an identification.  

 If the button interfaces LUXORliving T2, T4, T8 are already installed in the switch box, any 

of the connected buttons can be pushed three times briefly. The "magnifying glass" icon 

then indicates the respective button interface. The identification can be finished by 

pressing the button again briefly. 

 

 
 
After all devices have been identified and clearly named, configuration can be completed with 
"". 
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4.2.1.5 Create the device list manually 

If the PC is not connected to the LUXORliving system, or the LUXORliving components are not 
linked with each other, the device list can be created manually. This function allows 
configuration, without the installation being already started or completed. 

 Skip "Load system" and include the planned LUXORliving components in the device list. 

 
The arrangement of the devices in the left column (devices) can be adjusted by clicking, holding 
and moving. 

 

  
 
This device list can be used to continue configuration, and the individual functions of the added 
devices can be used inside the rooms.  
 

 It is absolutely necessary that the system is loaded, as soon as all LUXORliving 

components have been installed and linked with each other.  

 
After loading, the configured and found devices will be assigned. 
For identifying a device inside the installation, the list of the green-coloured devices on the right 
side is used. If you click on a green-coloured device, the red LED of that device flashes and thus 
allows its identification.  
 

 Draw this device on the corresponding red-coloured device in the device list and assign it to 

the appropriate functions. 

 

 If the button interfaces LUXORliving T2, T4, T8 are already installed in the switch box, any 

of the connected buttons can be pushed three times briefly. After that, one of the green-

coloured button interfaces on the right side flashes and indicates the respective button 

interface.  

 

 Press the button again briefly.  
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 The identification will be finished again. 

 

 
 

4.2.2 Include functions 

 
After the device list has been edited and completed, the main menu will be displayed. 
 

 
 

 Click on the "Rooms" field. 

 The building view will be opened and allows a room-based configuration of functions.  

 Click on the desired room, for instance the bedroom. 
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 Draw the desired function to the right and into the room. 

 

 

 
On the right side, devices appropriate for the selected function are displayed. 
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4.2.2.1 Switching 

 Pull the appropriate channel, which is highlighted in grey (e.g. switch actuator 1 C1), of a 

switch actuator to the "Switch actuator" field.  

 The parameter window of this switch function is opened. 

 
 
In the parameter window, the function can be named and various parameters can be set. 

 
Applications 
 
Switching: Switching on/off with optional time delay 
Cellar light: Switching on/off with additional automatic switch-off after the  

set time (with switch-off pre-warning as an option) 
Staircase light: Switching on with automatic switch-off after the set time. (with switch-off pre-

warning as an option) 
 

Afterwards, a "trigger" can be assigned to the switching channel. 

 



 Start-up 

 

LUXORliving system manual  20 

 

 

In the parameter window, the function can be named and various parameters can be set. 
 
Type 
Button:   Toggling function with each press of the button 
Motion detector:  "Switch“ function (rising edge = On / falling edge = Off) 
 
 

 Click on the "Group" field.  

 The window with the central and group functions is opened. 

 
 
Here, the channel can be integrated into existing group functions, and own groups can be 
added. The thresholds for twilight functions can be set in the settings of the weather station. 

 
A "trigger", e.g. the channel of a button interface, can be drawn on a group function and thus be 
triggered with this participant. 
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4.2.2.2 Dimming 

 Pull the appropriate channel of a dimming actuator to the "Dimming actuator" field.  

 The parameter window of this dimming function is opened. 

 

 
 
In the parameter window, the function can be named and various parameters can be set. 
 
Load selection 
Auto:   The connected load type is automatically detected by the dimming  
   channel. 
Inductive:  Dimming channel operates with leading edge control 
RC load:   Dimming channel operates with trailing edge control 
ESL-L and ESL-RC:  Settings for dimmable energy-saving lamps / 

Compact fluorescent lamps 
Dimming time:  The dimming time defines the dimming speed for the complete 

dimming range 0 …100 % 
Minimum dimming value: Adjustment to the connected lamp. If the  

lamp flickers, e.g. with dimming values < 10 %, the minimum dimming 
value has to be limited to 10 %. 

 
Afterwards, a "trigger" can be assigned to the dimming channel. 
 
 



 Start-up 

 

LUXORliving system manual  23 

 

 

 
 
In the parameter window, the function can be named. 
 
 

 Click on the "Group" field.  

 The window with the central and group functions is opened. 

 
 
Here, the channel can be integrated into existing group functions, and own groups can be 
added. The thresholds for twilight functions can be set in the settings of the weather station. 
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A "trigger", e.g. the channel of a button interface, can be drawn on a group function and thus be 
triggered with this participant. 

4.2.2.3 Blinds 

 Pull the appropriate channel of a blinds actuator to the "Blinds actuator" field.  

 The parameter window of this blinds function is opened. 

 

 
 
In the parameter window, the function can be named and various parameters can be set. 
 
Application "blinds" 
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For each blinds channel, the entire runtime, the time for a turn (step), as well as the 
participation in functions of the weather station can be set individually. 
Application "roller blinds" 

 

 
 
For each roller blind channel, the entire runtime, as well as the participation in functions of the 
weather station can be set individually. 

 
Application "awning" 

 

 
 
For each awning channel, the entire runtime, a canvas tightening, as well as the participation in 
functions of the weather station can be set individually. 

 
Afterwards, a "trigger" can be assigned to the awning channel. 
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For controlling blinds, roller blinds, or an awning, two inputs are necessary (Up/Down). This 
input pair will be assigned automatically. The first trigger that is assigned must have an odd 
channel number (C1, C3, C5, C7), and the second trigger will be added automatically (C2, C4, C6, 
C8). 
 
In addition, a "door contact" can be assigned to the blinds channel. The door contact prevents 
automatic travel with an open door or window. 
 

 
 
The setting "Operation with closed contact" depends on the contact used (NO contact (NO) or 
opening contact (NC)). 
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 Click on the "Group" field.  

 The window with the central and group functions is opened. 

 
 
Here, the channel can be integrated into existing group functions, and own groups can be 
added. 
The thresholds for sun protection or twilight function can be set in the settings of the weather 
station. 
 
A "trigger", e.g. the channel of a button interface, can be drawn on a group function and thus be 
triggered with this participant. 
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4.2.2.4 Heating 

 Pull the appropriate channel of a heating actuator to the "heating actuator" field.  

 The parameter window of this heating function is opened. 

 

 
 
 
In the parameter window, the function can be named and various parameters can be set. 
 
The control supports the operating mode "Heating", as well as "Heating and cooling". The 
installation type can be set for each operating mode. 
 
Installation type heating:  
Radiator: For fast acting heating systems, such as radiators or blower heaters 
Floor: For slow acting heating systems, such as water-using underfloor heatings  
 
Installation type cooling: 
Cooling ceiling: For slow acting cooling systems, such as water-using cooling ceiling 
Fan coil: For fast acting cooling systems, such as fan coil unit 
 
Subsequently, a "Sensor" can be assigned to the heating channel. 
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In the parameter window, the function can be named and various parameters can be set. 
 
Apart from limiting the minimum and maximum permissible set temperature, a room calibration 
can be performed. Room calibration allows a subsequent adjustment of the temperature 
measurement.  
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 Click on the "Group" field.  

 The window with the central and group functions is opened. 

 
 
In control type "Heating and cooling", a "trigger", e.g. a channel of a button interface, can be 
drawn on the "Heating/cooling" group function, and the configuration type can be set. 
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4.2.2.5 Scene 

The scene function can be used to assign inputs, e.g. a channel of a button interface, for 
triggering saved scenes. 
 
The participants and operations of the scenes are completely added and configured in the 
LUXORplay app. 
 
After adding a scene trigger, a trigger (e.g. a channel of a button interface) can be connected. 
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4.2.3 Weather station 

If a weather station was loaded or added to a device list, it will be displayed in the room view 
under "Central services". 

 

 
 

 Click on the "Weather station" field. 

  The parameter window is opened. 

The following functions can be set: 

Wind   Threshold 1 and threshold 2 

Frost   

Twilight  In the morning OFF, in the evening ON, in the morning UP, in the evening  

                           DOWN 

Sun protection  Sensor at front, sensor right, sensor left, maximum value 
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4.2.3.1 Wind 

 

 
 
For each wind channel (threshold 1 and threshold 2), wind speed and switch-off delay can be 
set individually. The wind speed has to be set after consulting the technician or manufacturer of 
the hangings.  
 
A larger switch-off delay minimizes the frequency of travel and thus provides a calm facade. 
Participation and operation in case of wind alarm can be set for each blinds function individually 
in room view. 
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4.2.3.2 Frost 

 

 
 
The "Frost" function prevents the automatic lowering of hangings when there is a risk of frost 
and allows the performance of a defined action in case of frost alarm. Participation and 
operation in case of frost alarm can be set for each blinds function individually in room view. 
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4.2.3.3 Twilight 

 

  
 
The "twilight" function includes four different dimming functions. In room view, each of these 
functions can be assigned individually to the switch, dimming, and blinds functions. 
 
In the morning OFF: This function can be used in connection with switch and dimming  
   functions and allows an automatic switch-off if the set brightness  
                                        value is exceeded. 
In the evening ON: This function can be used in connection with switch and dimming  
                                        functions and allows an automatic switch-on if the brightness value  
                                        falls below the set value. 
In the morning UP:         This function can be used in connection with blinds functions and  
                                        allows an automatic up travel (to the upper end position) if the set 

             brightness value is exceeded. 
In the evening DOWN: This function can be used in connection with blinds functions and     

allows an automatic down travel (to the lower end position) if the 
brightness value falls below the set value. 

 
For each function, the brightness threshold and the delay times can be  
set individually. 
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4.2.3.4 Sun protection 

 

 
 
The "Sun protection" function includes four different functions. In room view, each of these 
functions can be assigned individually to the blinds functions. 
 
Sensor at front: The sensor at the front of the weather station detects the brightness and 

carries out, for instance, the automatic shading control of the south facade.  
Sensor right: The sensor at the right side of the weather station detects the brightness and 

carries out, for instance, the automatic shading control of the east facade. 
Sensor left: The sensor at the left side of the weather station detects the brightness and 

carries out, for instance, the automatic shading control of the west facade. 
Maximum value: All three sensors of the weather station detect the brightness. As soon as the 

measurement value of one of the sensors exceeds the set switching threshold, 
the set positions are approached.  
 

For each function, the position "height" and "slat" can be set in percentage values. 
The delay times are non-adjustable (exceeding: 3 minutes, falling below: 20 minutes). 
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4.3 Programming with LUXORplug 
 
After the functions have been assigned to the rooms and set, the system can be programmed. 
This step is possible any time, even if only single functions have been added. 

 For programming, open the main menu. 
 
 

 
 

 Click on the "System" field. 

 The submenu is opened. 

 

  

 Click on the "Program system" field and then on "Start". 
 
Here, you can also overwrite devices which have been installed, but not yet included in your 
project. This ensures that these devices do not disturb the functions included in the project. 
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At the first time, programming will take a little longer, since all device parameters have to be 
transferred. Subsequent programming is faster. 
Successful programming will be acknowledged. 
 
After successful programming, the configured functions are available in the system. 
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4.4 Prepare LUXORplay 
 
In order for the LUXORplay app to be able to access the programmed functions, this has to be 
prepared in the "System" menu. 

 Click on the "Prepare LUXORplay" field and start the data transmission to the system 

centre.  
 
For the transmission, a password for the administrator has to be defined (default password: 
admin)2. The password can be changed or defined by clicking on the password settings.  
 
If the password gets lost, the LUXORliving IP1 system control centre has to be reset with a 
master reset. This can be done directly at the device ("Reset" menu – "Master Reset"). 
Afterwards, the password can be created again via LUXORplug. 
 
 

 
  

                                                 

 

 
2 In the LUXORplay app, the administrator has to authenticate himself with this password, in order to be 
able to create other users and define their rights as well as individual passwords for each user. 
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4.5 Set interface 
 
Another function in the "System" menu allows the setting of the LUXORliving IP1 system control 
centre. Principally, the system control centre is automatically detected. If this is not the case, the 
IP address of the connected system control centre can be entered manually in this menu. You 
can read the IP address of the system control centre in the display. 
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4.6 Diagnosis 
 
The "Diagnosis" menu allows a recording of the bus communication. This tool is intended to 
facilitate start-up and, if necessary, troubleshooting. The recording can be started, stopped and 
saved. 
 

 Click on the "Home" menu. 

 The following window will open:  
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5 Appendix 

5.1 Debug mode 
 

 
 
Debug mode can be activated by clicking five times on the free space. It is used for 
troubleshooting in the configuration.  
 
In debug mode, the connected group addresses are displayed for each function if the cursor is 
placed on it. 
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In the "Device list" menu of the debug mode, you can also manually search for devices which 
are not included in the configuration or which have incompatible addressing. 
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